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Notice 

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 

product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of 

these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or 

other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 

document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or 

others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 

manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 

and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 

each Renesas Electronics product depends on the product’s quality grade, as indicated below. 

 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 

 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 

Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 

human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system; 

undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims 

any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is 

inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 

hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not 

limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 

ELECTRONICS DOES NOT WART OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 

RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 

HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 

ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 

PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 

RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE 

IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 

Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 

specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products 

are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, 

injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety 

design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging 

degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 

responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 

controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 

applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 

with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 

promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 

transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 

subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics. 
(Rev.5.0-1  October 2020) 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit 

Products 

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the products 

covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement 

tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be 

touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 

2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in 

a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level 

at which resetting is specified. 

3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements. 

Follow the guideline for input signal during power-off state as described in your product documentation. 

4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 

5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced 

with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 

6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL (Max.) 

and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level 

is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 

7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 

8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of 

internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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Licensing 

 

This product uses the IronPython based on the following license. 

 

Copyright 2026 Renesas Electronics Corporation 

 

Licensed under the Apache License, Version 2.0 (the "License"); 

you may not use this file except in compliance with the License. 

You may obtain a copy of the License at 

 

     http://www.apache.org/licenses/LICENSE-2.0 

 

Unless required by applicable law or agreed to in writing, software 

distributed under the License is distributed on an "AS IS" BASIS, 

WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. 

See the License for the specific language governing permissions and 

limitations under the License. 
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GUI Graphical User Interface 
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IDE Integrated Development Environment 
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LM Load Module 

MCU Microcontroller Unit 
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PIL Processor in the Loop 
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1.   GENERAL 

This chapter provides an overview of the functions of “Embedded Target (Processor in the Loop Simulation 

System)”.  

1.1 Overview 

Embedded Target facilitates the verification of algorithms in embedded models by generating a test environment 

automatically in Processor in the Loop Simulation System (hereafter referred to as PILS). 

Figure 1-1. Flow of Processing for Generation of Test Environment 

Remark Embedded Target executes operations (1) to (5) in the above figure automatically.  
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1.2 Features  

This section lists the features of Embedded Target.  

1. Generation of test environment 

The following processing operations, which are necessary to generate a test environment for PIL 

simulation, can be executed automatically. The processing operations vary depending on the target for 

code generation: a Subsystem block, a reference model or a top-level model. 

A. Subsystem block 

a. Generation and replacement of a block for PIL linking 

b. Generation of C source files 

c. Start-up of CS+/e2 studio 

- Registration of C source files 

- Property setting 

- Generation of a load module 

- Connection of a debug tool 

- Download of a load module 

d. PIL simulation is executed manually after generation of a test environment. 

B. Reference model or top-level model 

a. PIL mode specification (Set it beforehand when creating a model) 

b. Generation of C source files 

c. Start-up of CS+/e2 studio 

- Registration of C source files 

- Property setting 

- Generation of a load module 

- Connection of a debug tool 

- Download of a load module 

d. PIL simulation is executed automatically after generation of a test environment 

2. Algorithm verification 

PIL Simulation, which is sequentially executed in combination with MATLAB®/Simulink® and CS+/e2 studio, 

enables the verification of algorithms for the load module generated by embedded models. The load 

module can be executed on 1 core (hereafter, referred to as Single-Core PIL Simulation) or multi-core 

(hereafter, referred to as Multi-Core PIL Simulation) depending on the hardware capability of the target 

device. 

3. Measure the algorithm performance of embedded models 

Embedded Target supplies the execution time measurement (hereafter, referred to as Performance 

Measurement or Software Trace) of the PIL Simulation by executing the load module, generated by 

embedded models, on CS+/e2 studio. The measurement result (automatically saved in file format) provides 

different execution time information in according to the PIL Simulation mode and the measurement 

method. 

4. Multiple code generation targets (block and model) 

The following code generation targets are supported: 

- Subsystem block 

- Reference model 

- Top-level model 



Embedded Target V6.10.00  1.   GENERAL 

R20UT5787EJ0100 Rev.1.00  Page 11 of 101 
Feb.01.26   

 

 

Remarks 

1. Multi-Core PIL Simulation only supports RA8 Multi-Core Device Series 

2. The Time Measurement method for Single-Core PIL Simulation is referred to as Performance 

Measurement, while that for Multi-Core PIL Simulation is referred to as Software Trace. 
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1.3 Operating Environment  

Below descriptions are the system requirements for Embedded Target. 

1. Hardware environment 

Operating system Microsoft® Windows® 10 (64-bit) and Microsoft Windows® 11 (64-bit) (Windows® 11 is 

recommended) 

Processor  1 GHz or higher (supporting hyper-threading or Multi-Core CPU) 

Main memory 4 GB or more is recommended Software environment 

 

2. MATLAB® and Simulink® products (from MathWorks, Inc.) 

MATLAB®   R2018b, R2022b to R2025b (R2025b is recommended) 

Simulink®    Same as above 

Stateflow®   Same as above 

MATLAB® Coder™   Same as above 

Simulink® Coder®   Same as above 

Embedded Coder®  Same as above 

 

3. MEX-file compiler  

MEX-file is the interface that invokes C library from MATLAB®. MEX-file compiler is used to compile MEX 

files. 

Embedded Target has been tested with the following compilers as the MEX file compiler for Windows® 

10: 

- Microsoft Visual C++ 2015 compiler (from Microsoft Corporation) (for MATLAB® R2018b) 

- Microsoft Visual C++ 2019 compiler (from Microsoft Corporation) (for MATLAB® R2022b to R2025b) 

- Microsoft Visual C++ 2022 compiler (from Microsoft Corporation) (for MATLAB® R2022b to R2025b) 

- MinGW 6.3 C/C++ (distributed by mingw-w64) (only when using MATLAB® R2018b and R2022b to 

R2025b) 

- MinGW 8.1 C/C++ (distributed by mingw-w64) (only when using MATLAB® R2023a to R2025b) 

Reference: System Requirements & Platform Availability 

https://www.mathworks.com/support/requirements/matlab-system-requirements.html 

 

4. IDE (from Renesas Electronics)  

CS+  V8.15.00  

e2 studio 2025-10, 2025-12 

 

5. Building environment (for generating a load module) 

CC-RX    Included with CS+ V8.15.00 or later (from Renesas Electronics) 

    Installed along with e2 studio 

CC-RL    Included with CS+ V8.15.00 or later (from Renesas Electronics) 

    Installed along with e2 studio 

GNU ARM Embedded  (version: 13.2-Rel1 or later) 

 

Remarks 

1. For the MATLAB® and Simulink® products, an environment is constructed by using optional products 

corresponding to the versions of MATLAB® and Simulink® being used. 

2. When installing MATLAB®, it is recommended that the installation folder is changed to other than the 

folder for UAC (user account control). Depending on the version of MATLAB® in use, if the installation 

https://www.mathworks.com/support/requirements/matlab-system-requirements.html
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folder is the folder for UAC such as “<system drive>: \Program Files”, a problem such that MEX 

cannot be built or the MATLAB® path cannot be saved may occur. 

3. The IDE is CS+ or e2 studio. 

 

6. Debug Tools 

Emulator E1, E2, E2 Lite, E20, EZ Emulator (For RL78 only), COM Port (For RL78/G23, RL78/G24 and 

RL78/L23 only) (from Renesas Electronics), 

J-Link (For RA device family and some device series of RX on e2 studio only)  

Simulator (Excluded RA devices family) (from Renesas Electronics) 

Remark  

1. The simulator is included with CS+/e2 studio 

2. RL78/F22, RL78/F25 only supports these debug tools: E2, E2 Lite, Simulator 

3. RX14T only supports these debug tools: E2, E2 Lite, J-Link  

 

7. MATLAB®, MATLAB® Coder™, Simulink® Coder™, Embedded Coder ® are trademark or registered 

  trademark of the MathWorks, Inc. 

  (https://www.mathworks.com/company/aboutus/policies_statements/trademarks.html) 

 Microsoft®, Windows®, Visual C++® are registered trademarks or trademarks of Microsoft Corporation 

  in the United States and/or other countries. 

  (https://www.microsoft.com/en-us/legal/intellectualproperty/trademarks/en-us.aspx) 
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1.4 Feature Use Cases Policy 

Embedded Target offers various features to verify algorithms of embedded models. This chapter describes use 

cases of these features. 

1.4.1 Feature Use Cases 

1.4.1.1 Target Devices for PIL Simulation 

Embedded Target supports verifying algorithms of embedded models by PIL Simulation on various Renesas 

MCU families including RX, RL78, RA.  

1.4.1.2 Build Tools for Target Devices  

The Load Module, which is generated from embedded models, can be generated by Renesas Compilers for 

RX, RL78 device family and GNU ARM Embedded for RA device family. 

1.4.1.3 Target MCU 

Depending on the hardware capability of target device for PIL Simulation, Embedded Target offers Single-Core 

& Multi-Core Target MCU. The Target MCU denotes the number of cores that a load module can execute during 

the PIL Simulation: 

• Single-Core PIL Simulation: the load module can execute on 1 core of the target device. This feature can 

be used on all supported MCU families by Embedded Target 

• Multi-Core PIL Simulation: the load module can execute on multi-core of the target device. This feature 

only can be used on RA8 Multi-Core MCU families by Embedded Target 
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1.5 Basic Usage 

The usage is different depending on the code generation target: a Subsystem Block, a Reference model or a 

Top-level model. The usage for each of the cases is described below. Refer to the description according to the 

Simulink® model being used. 

Remark For Multi-Core PIL Simulation on RA8 Multi-Core devices, use a multi-core model ending in 

multicore. To convert a standard model to a multi-core model, refer to Chapter 3.2.1 

Procedure for Manually Specifying Core Targets (Multi-Core MCU) 

1.5.1 When Using a Subsystem Block 

When the target for code generation is a Subsystem block, use Embedded Target in accordance with the 

following procedure. 

1. Create a Simulink® model. Convert the code generation target blocks to the Subsystems and group them 

into a single Subsystem block.  

 

Figure 1-2. Subsystem Model 

  



Embedded Target V6.10.00  1.   GENERAL 

R20UT5787EJ0100 Rev.1.00  Page 16 of 101 
Feb.01.26   

 

 

2. Use the configuration dialog box to set necessary parameters for generation of codes and a test 

environment. 

 

  

  

  

Figure 1-3. Configuration Parameters setting 
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3. Execute the ecpils_build command in the MATLAB® command window to generate codes and to generate 

a PIL test environment. Generate a C source code and start CS+/e2 studio. The Simulink® model replaces 

the generated block for PIL sequential execution with the Subsystem block. 

 

 

Figure 1-4. Flow of Embedded Target Processing, Case: Subsystem  
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4. Start simulation using the Simulink® model to execute PIL simulation. 

 

 

Figure 1-5. Flow of PIL Simulation, Case: Subsystem 

 
For more information, see 3.4 Executing PIL Simulation for Subsystem Code Generation Target Block. 
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1.5.2 When Using a Reference Model 

When the target for code generation is a reference model, use Embedded Target in accordance with the 

following procedure. 

1. Create a Simulink® model. The target for code generation is a Model block. 

 

Figure 1-6. Reference Model 
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2. Use the configuration dialog box to set necessary parameters for generation of codes and a test 

environment. 

  

  

  

 

Figure 1-7. Configuration Parameters setting   
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3. Set PIL mode for the Model block. 

 

Figure 1-8. Block Parameters setting 
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4. Start simulation using the Simulink® model. Code generation, test environment generation and PIL 

simulation are executed automatically.   

 

Figure 1-9. Flow of Embedded Target Processing, Case: Reference Model  

 

For more information, see 3.5 Executing PIL Simulation for Reference Code Generation Target Model.  
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1.5.3 When Using a Top-level Model 

When the target for code generation is a top-level model, use Embedded Target in accordance with the following 

procedure. 

1. Create a Simulink® model. The target for code generation is a top-level model. 

 

Figure 1-10. Top-level Model 
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2. Use the configuration dialog box to set necessary parameters for generation of codes and a test 

environment. 

  

  

  

 

Figure 1-11. Configuration Parameters setting  
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3. Set PIL mode for the Simulink® model. 

 

Figure 1-12. PIL Mode Setting 

4. Start simulation using the Simulink® model. Code generation, test environment generation and PIL 

simulation are executed automatically.  

 

 

Figure 1-13. Flow of Embedded Target Processing, Case: Top-level Model  
 
For more information, see 3.6 Executing PIL Simulation for Top-level Code Generation Target Model.   
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   INSTALLATION 

This chapter explains how to install and uninstall Embedded Target.  

2.1 Installing Embedded Target 

Described below is the information about the Embedded Target package and the installation procedure. 

2.1.1 Package 

The following installation file is necessary to install Embedded Target. 

• Renesas_Embedded_Target_<version information>_Setup.exe 

After installed Embedded Target, the programs, documents, and samples are in the following folder structure. 

<version information>\ et\ A set of Embedded Target programs 

 et\plugins\IronPython A package of IronPython 2.7.4 

 smp\ Sample models 

2.1.2 Procedure 

See the Quick Started Guide and complete installation, license addition, and making initial settings. 

2.2 Uninstalling Embedded Target  

Proceed as follows to uninstall Embedded Target. 

1. Start MATLAB® and remove the <Embedded Target installation folder>\<version 

information>\ EmbeddedTarget folder using the Set Path dialog box.  

  

Figure 2-1. Set Path Dialog Box  
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2. Delete the <Embedded Target installation folder>\<version information> folder and delete the files in 

<MATLAB® install folder>\bin\win64\ (when using MATLAB® 64-bit versions) which has been copied in 

installation. 
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   FUNCTIONS 

This chapter describes the functions provided by Embedded Target. 

3.1 Overview 

Embedded Target provides the functions to generate a test environment and to verify algorithms. 

Embedded Target generates a test environment in cooperation with the Embedded Coder®.  

Code can be generated for three kinds of targets: a subsystem block, a reference model, and a top-level model. 

The procedure to generate a test environment is different in these three kinds.  

Table 3.1-1. Three Kinds of Code Generation Targets 

Code generation 
target 

Subsystem block Reference model Top-level model 

Input/output for 

generated code 

Uses an I/O port of the 

subsystem block. 

Uses an I/O port of the 

model block. 

Uses the MATLAB® 

workspace variable. 

PIL sequential execution Performs PIL sequential 

execution by replacing the 

subsystem block with the 

block for PIL sequential 

execution. 

Sets the PIL mode for the 

model block and performs 

PIL sequential execution. 

Sets the PIL mode for the 

model and performs PIL 

sequential execution. 

 

1. When the target for code generation is a subsystem block 

A block for PIL sequential execution is generated from the Subsystem block and verification is performed 

by replacing that block with the Subsystem block. 

a. Generate the block for PIL sequential execution from an embedded model using a C code 

generation tool (Embedded Coder®) 

b. Replace the block for PIL sequential execution with an embedded model Subsystem block 

c. Generate C source files from an embedded model using a C code generation tool (Embedded 

Coder®) 

d. Start CS+/e2 studio 

e. Register the generated C source files in the CS+/e2 studio project 

f. Select the debug tool to use when running PIL simulation 

g. Generate a load module from the C source files using the build function of the build tool of CS+/e2 

studio 

h. Download the generated load module into the debug tool 

i. Information obtained from PIL simulation allows you to verify the algorithms in an embedded model 
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2. When the target for code generation is a top-level model or a reference model 

When the target for code generation is a top-level model or a reference model, a test can be performed by 

setting PIL mode before running simulation, unlike when the target is a Subsystem block. Once a test is 

started, C source files and a CS+/e2 studio project file are generated automatically. A test is performed by 

using them for communication with CS+/e2 studio. 

a. Prepare a top-level model or a reference model 

b. Set the configuration parameters 

c. Specify PIL mode as simulation mode 

d. Generate C source files from an embedded model using a C code generation tool (Embedded 

Coder®) 

e. Start CS+/e2 studio 

f. Register the generated C source files in the CS+/e2 studio project 

g. Select the debug tool to use when running PIL simulation 

h. Generate a load module from the C source files using the build function of the build tool of CS+/e2 

studio 

i. Download the generated load module into the debug tool 

j. Information obtained from PIL simulation allows you to verify the algorithms in an embedded model  

Sections of “Executing PIL Simulation for Subsystem Code Generation Target Block”, "Executing PIL Simulation 

for Reference Code Generation Target Model", and "Executing PIL Simulation for Top-level Code Generation 

Target Model" describe the cases when the target of code generation is the subsystem block, the reference 

model and the top-level model, respectively. 
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3.2 Specifying Core Target 

In Embedded Target, the core allocations can be specified manually for a Multicore MCU. This section explains 

the procedure for specifying them. 

3.2.1 Procedure for Manually Specifying Core Targets (Multi-Core MCU) 

Currently, this step is only implemented for RA devices that support multi-core on e2 studio from FSP Version 

6.0.0 or later. 

The explanation below is given by taking the procedure for specifying core targets and generating multi-core 

model as an example. 

1. Open the [Configuration Parameters] dialog box by selecting the Subsystem block targeted or Reference 

Model or Top-level Model for PIL simulation. 

2. In [Embedded Target Options] under [Code Generation], please setting according to the conditions below: 

a. [IDE Target]: e2 studio 

b. [Device Family]: RA 

c. [FSP Version]: 6.0.0 or later 

d. [Device Name]: RA8 Multi-Core 

e. [Target MCU]: Multi-Core MCU 

3. Clicking on the [Convert Model for Multi-Core MCU] button 

4. The list of Subsystem blocks is displayed in a tree view format. In the initial state, all blocks are specified 

for “CPU0 (Cortex-M85)”. This core number in the initial state corresponds to the smallest number of the 

CPU of the target device. 

Figure 3-1. Convert Model for Multi-Core MCU for RA8 Multi-Core devices 
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• When the form for specifying core is opened, an intermediate file (tmp_cagOut.json) for saving core 

target information is generated. 

• When the form for specifying core targets is opened, a clone model for viewing purpose is shown with 

“clone_” prefixed to the original model file name. 

• The original model will be temporarily hidden to avoid modifying the model before it is converted (if you 

have set [Files and folders] - [Hidden files and folders] - [Don’t show hidden files, folders and drivers] 

flag of File Explorer). 

• When the form for core targets is closed because model conversion ended, model conversion was 

aborted by the [Cancel] button being clicked on, or some kind of error has occurred, the clone model 

will be deleted. 

• There are two new features.  

o Export: Saves the current allocation information (subsystem name, hierarchical structure, 

whether it is a CPU number) in the form for specifying core targets in a file. This file will be the 

input file for the import function. 

▪ Click on the [Export] button in the form for specifying core targets. 

Figure 3-2. Choosing Subsystem Blocks for Model Conversion 
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▪ A file selection dialog box will open. Specify the location to save the file and the file 

name, then click on the [Save] button to save the file. 

 

If saving of the file fails for some reason (e.g. the file was opened by another 

processing), error message E0702 is displayed, and the screen returns to the form for 

specifying measurement targets. 

 

 

Figure 3-3. [Export] Button in Form for Specifying Core Targets 

Figure 3-4. File Selection Dialog Box (Export Function) 
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▪ The screen also returns to the form for specifying core targets after export of the file 

finishes. 

o Import: Reads the file that was generated by the export function and restores various allocation 

information. This function facilitates re-allocation of core targets. 

Remark 

1. The core target information file of a different model cannot be used for the current 

model because the allocation information may not match. 

2. Manual modification of the core target information file is prohibited because correct 

operation cannot be guaranteed. 

Import the file that was saved using the export function following the procedure below.  

▪ Click on the [Import] button in the form for specifying core targets. 

 

Figure 3-5. Export Failure Message Box 

Figure 3-6. [Import] Button in Form for Specifying Core Targets 
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▪ A file selection dialog box will open. 

Select the file and click on the [Open] button to specify the target file. If the file specified 

in the dialog box cannot be opened for some reason, error message E0705 is displayed, 

and the screen returns to the file selection dialog box. 

▪ If the core target information is compatible with the model, the import completion 

message box will be displayed. 

If not compatible, error message E0703 or E0704 will be displayed. 

▪ The imported information is reflected in the form for specifying measurement targets. 

 

 

 

 

 

 

Figure 3-7. File Selection Dialog Box (Import Function) 

Figure 3-8. Import Completion Message Box 
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When a core target block is selected, the following operations are performed according 

to the user's actions.  

- If the checkbox of a core target block is unchecked, all subsystems in lower layers of 

this block are selected and considered as core target blocks.  

- If a subsystem in an upper layer of a core target block is selected, the checkboxes of 

all subsystems in the same layer with this core target block are unchecked. With 

consideration to the above operations, make sure that all necessary subsystems (core 

target blocks) are selected. 

5. When specifying core allocation, select a core number in the combo box on the right of each core target 

block. 

Remark 

1. All Subsystem blocks that are connected in a loop must be allocated to the same core. Otherwise, 

a deadlock will occur because Subsystem blocks must wait for output from other subsystems. 

Up to two cores can be selected in the form for specifying measurement targets. However, the core 

numbers must be the same as those of the actual device to execute the PIL simulation. For detail, 

the value core can select refer below table 

Table 3.2-1. Value core can select for form for specifying core targets 

MCU architecture Device Series Value core can be select 

RA8 RA8P1 

RA8D2 

RA8M2 

RA8T2 

CPU0 (Cortex-M85) 

CPU1 (Cortex-M33) 

 

Figure 3-9. Restoring Core Target Information Using the Import Function 
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6. If you want to cancel the model conversion procedure for some reason, click on the [Cancel] button to close 

the form for specifying core targets. 

7. After you have chosen the Subsystem blocks to allocate core targets, click on the [Generate] button to 

generate core target information files. 

 

Figure 3-10. Specifying Core Targets 

Figure 3-11. Generating the Core Target Information Files. 
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8. After core target information files have been generated successfully, click on the [Convert] button to begin 

converting the model. 

• After the form for specifying core targets has been opened, if the user do not change any core for Core 

Targets block and clicks on the [Convert] button without using the [Generate] button to generate core 

target information files, the form for specifying core targets will close without any action. 

• After generating core target information files for at least once (M2PInterfaceCore.csv and 

M2PInterfaceConn.csv exist), if the user changes the core targets again and then clicks on the [Convert] 

button without generating new core target information files, a confirmation dialog box will appear to 

notify the user that new core target information files will be re-generated and model conversion will 

proceed. In the confirmation dialog box, click on the [OK] button to convert the model or click on the 

[Cancel] button to do nothing 

Remark 

1. If the [Generate] button is not clicked on or the core target information files are not generated, model 

conversion will be terminated. 

2. During model conversion, a message box says “Converting model. Please wait…” is displayed. It 

will be closed automatically after model conversion is completed. 

 

Figure 3-12. Model Conversion Confirmation Dialog Box When Clicking on 

the Convert Button for Specifying Core Targets 

Figure 3-13. Waiting for Model Conversion 
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3. Also, you will see a message box saying: “Script creation completed.” Click on the [OK] button to 

continue. 

 

9. Upon completing step 8, the “_multicore” model is created and opened automatically. 

Remark If the target for model conversion is a referenced model, a model named “_multicore” is also 

created. 

At the end of the model conversion process, if the original model has disappeared from the MATLAB workspace, 

there is a prepared script file “recover_env.m” for the user to manually return the environment to its original state 

(redisplays the original model and closes and deletes the clone model). In such a case, execute recover_env in 

the MATLAB command window. 

3.3 Nesting of Reference models 

This section describes about structure and features of nesting of Reference models. This feature only applies 

for Subsystem and Reference models. 

The following figures describe about nesting of Reference models: 

Figure 3-14. Creation of Model Conversion Script was 

Completed. 
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• Code generation target can contain multiple Model and Subsystem blocks. 

 

 

• Each Model block refer to a model. This makes the nesting of Reference models. 

 

 

Figure 3-15. Layer under the Code generation target 

Figure 3-16. Nesting of Reference models 
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• For all Model blocks under the Code generation target block are set to [Normal] of [Simulation mode] 

option. 

 

 

• The Configuration Parameters setting for the nesting of Reference models must be the same with main 

model and Referenced models. 

Remarks 

There are some following settings are necessary. If do not set them, PIL Simulation execution 

may be error. 

1. [Solver] -> [Type] set to [Fixed-step] 

2. [Model Referencing] -> [Total number of instances allowed per top model] set to [One] 

The model conversion for nesting of Reference models is proceeded as same as the normal model – refer to 

section 3.2.1 Procedure for Manually Specifying Core Targets (Multi-Core MCU) 

When using the CAG tool for model conversion: 

• For Subsystem model: Subsystem and Model blocks under Code generation target can be assigned as 

the measurement targets. But only Model blocks in the main model are assigned because Model blocks 

that located in other models cannot be measured. 

• For Reference model: only Subsystem and Model blocks located in the Referenced model of Code 

generation target can be assigned as the measurement targets. The Subsystem and Model blocks 

located in the other Referenced models cannot be assigned and measured. 

The PIL Simulation execution and time measurement are proceeded as same as the normal model. But there 

are some different points as below: 

• All models of nesting of Reference model are also built and generated code. 

• The generated source code of each model in nesting of Reference models will be add sequentially to 

the same location with main model. 

Figure 3-17. Simulation mode option of Model block 
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• Source code “< BlockName >_<TargetMCU>_Launch_GraphViewer.m” and “< BlockName 

>_Convert_Measurement._Data.m” of nesting of Reference models will be deleted after source code of 

the main model is generated. 

3.3.1 Restriction 

The following is the restrictions of nesting of Reference models: 

1. When create the nesting of Reference models, the model name of the nesting of Reference models 

must be unique with the first 15 characters. If it is not unique, it will cause error for code generation after 

that. 

 

2. When use [Template Project & LM Download] mode with the nesting of Reference models, the models 

of current project must have the structure (e.g., the number of nested models, nested model name) that 

be the same with the models of template project. If they are different, it will cause error when building 

CS+/e2 studio project. 

 

  

Figure 3-18. Example of the unique model name 
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3.4 Executing PIL Simulation for Subsystem Code Generation Target Block 

The following describes how to generate a test environment necessary for PIL simulation when the target for 

code generation is a subsystem block. 

3.4.1 Generating a Test Environment 

This section explains how to generate a test environment necessary for PIL simulation.  

The explanation uses a sample model DataTypes.slx provided with Embedded Target for Single-Core PIL 

Simulation modes. In case of run PIL Simulation with RA8 Multi-Core, refer chapter 3.2.1 Procedure for Manually 

Specifying Core Targets (Multi-Core MCU) to how to convert multi-core model. 

3.4.1.1 Prepare debug configuration for Non-secure with Secure Bundle for RA family 

To execute PIL Simulation with RA TrustZone® Non-Secure project successfully, which needs to refer to the 

smart bundle (*.sbd) file of RA TrustZone® Secure project type. So, in this section describes how to generate 

RA TrustZone® Secure project and necessary settings to do this. 

• Step 1: Open e2 studio, create project RA TrustZone® Secure project using the following link: 

Generating an RA Secure Project for e² studio. 

• Step 2: Connect to the target device. Select [Menu Bar] > [Run] > [Renesas Debug Tools] > [Renesas 

Device Partition Manager].  

In [Renesas Device Partition Manager] > Select [Device Family] is “Renesas RA” > Check on checkbox 

[Initialize device back to factory default] > Click “Run” and “Close” as below images: 

 

• Step 3: Build & Download RA TrustZone® Secure project on Step 1. 

• Step 4: Terminate current debug session. 

Figure 3-19. Renesas Device Partition Manager for RA TrustZone® Secure 

https://www.youtube.com/watch?v=JOov9B2cG_g


Embedded Target V6.10.00  3.   FUNCTIONS 

R20UT5787EJ0100 Rev.1.00  Page 43 of 101 
Feb.01.26   

 

• Step 5: Disconnect and re-connect to the target device. Select [Menu Bar] > [Run] > [Renesas Debug 

Tools] > [Renesas Device Partition Manager]. 

Setting as below images, click “Run” and “Close” as below images: 

o In [Renesas Device Partition Manager] > Select [Device Family] is “Renesas RA” > Uncheck 

on checkbox [Initialize device back to factory default] > Check on checkbox [Change debug 

state] > Select [Debug state to change to] is “Non-secure Software Development” > Click [Run] 

and [Close] as below images: 

 

• •Step 6: Close e2 studio. 

3.4.1.2 Embedded Model Subsystem 

Convert embedded model blocks from which a C source file will be generated to a subsystem. 

Remark In the sample models provided with Embedded Target, blocks have already been converted to 

subsystems. Therefore, there is no need to convert blocks in the sample models to subsystems.  

The following table shows the block name of the subsystem in the sample model.  

Table 3.4-1. Subsystem Block Name 

3.4.1.3 Setting configuration parameters 

Embedded Target implements execution of test environment generation by interworking with Embedded 

Coder®. Therefore, it is necessary to check/set Embedded Coder® options when using the test environment 

generation functions provided by Embedded Target. 

1. Open the Configuration Parameters dialog box 

Sample model name Code generation target Subsystem block name 

DataTypes.slx Subsystem block DataTypes_PIL 

Figure 3-20. Renesas Device Partition Manager for RA TrustZone® Non-Secure 
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Select [Model Configuration Parameters] from the [Simulation] menu in the DataTypes window to open the 

Configuration Parameters dialog box. 

 

2. Set [Hardware Implementation] options 

Select [Hardware Implementation] in the [Select] area and select [Renesas] for [Device vendor]. Then 

make the settings described below and click the [Apply] button. 

[When using RX] 

Select [RX] for [Device type]. 

Select [Little Endian] or [Big Endian] for [Byte ordering]. 

 

Figure 3-21. [Hardware Implementation] Options for RX 

[When using RL78 or RA] 

Select [RL78] or [ARM Cortex] for [Device type] in MATLAB R2018b (or [ARM Cortex-M] for R2022b and 

latest). 

[Byte ordering] is set as [Little Endian] and cannot be changed. 
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Figure 3-22. [Hardware Implementation] Options for RL78 

  

Figure 3-23. [Hardware Implementation] Options for RA 

Remark 1. Device type value in [Hardware Implementation] panel can be changed by setting Device 

Family value in [Embedded Target Options] panel. This result goes into effect after pressing 

“OK” or “Apply” button on [Embedded Target Options] panel. 

 2. The setting of Device Family value is enabled when [IDE Mode] value is Create Project on 

[Embedded Target Options] panel. 

3. Set [Code Generation] options 

Select [Code Generation] in the [Select] area. Then make the settings shown in the figure below and click 

the [Apply] button.  
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Figure 3-24. [Code Generation] Options 

Remark The template make file (ecpils.tmf) will be overwritten according to selected Mex compiler 

(>>mex -setup). 

4. Set [SIL and PIL Verification] or [Verification] options 

Select [Code Generation] - [Verification] in the [Select] area. Then make the settings shown in the figure 

below and click the [Apply] button.  

 

Figure 3-25. [Verification] Options  
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5. Set [Embedded Target Options] 

Select [Code Generation] - [Embedded Target Options] in the [Select] area. Then make the settings shown 

in the figure below and click the [Apply] button.  

 

Figure 3-26. [Embedded Target Options] Settings  

The following table shows the items in the [Embedded Target Options] pane. 

Table 3.4-2. Embedded Target Options 

Item name Description 

IDE Target *1 Select the IDE which you want to use. IDE is CS+ (default) or e2 studio. 

[Use default IDE Install 
Directory] checkbox 

This option sets the default IDE installation directory of selected IDE target to 
[IDE Install Directory] option. 

• For CS+: "C:/Program Files (x86)/Renesas Electronics/CS+/CC" 

• For e2 studio: "C:/Renesas/e2_studio" 

If the default IDE installation directory is invalid, this option is unchecked 
automatically and the value of [IDE Install Directory] option is changed to 
empty. 

IDE Install Directory *2 
Specifies the folder where CS+/e2 studio has been installed (the folder where 
CubeSuiteW+.exe or e2studio.exe is stored) as an absolute path. 

[Select IDE Install 
Directory] button *2 *3 

Clicking this button displays the dialog box for selecting the absolute path of 
the folder where the CS+/e2 studio is installed. Folder specifications made in 
the dialog box that is opened by this button are reflected in the [IDE Install 
Directory] field. 

Workspace Directory 
Specifies the workspace folder where e2 studio project has been stored as an 
absolute path. 

[Select Workspace 
Directory] button *4 

Click this button to display the dialog box for selecting the absolute path of the 
workspace folder of e2 studio. Folder specifications made in the dialog box that 
is opened by this button are reflected in the [Workspace Directory] field. 

e2 studio Support Area 
*5 

Specifies the e2 studio support folder where e2 studio generates Integration 
Service API to drive it as an absolute path 
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[Select e2 studio Support 
Area] button *6 

Clicking this button to display the dialog box for selecting the absolute path of 
the e2 studio support folder. Folder specifications made in the dialog box that is 
opened by this button are reflected in the [e2 studio Support Area] field 

IDE Mode *7 

Selects the type of project file that is loaded when the CS+/e2 studio starts and 
whether a series of processing including download of a load module is 
performed after the CS+/e2 studio start-up. 

Create Project 
The default CS+/e2 studio project file provided 
by Embedded Target is loaded (default). 

Open Project 
The CS+/e2 studio project file saved at the last 
exit is loaded. 

Open Project  

& LM Download 

The CS+/e2 studio project file saved at the last 
exit is loaded on start-up. Then, a load module 
is downloaded to the debug tool.  

Template Project  

& LM Download 

The CS+/e2 studio project file generated based 
on the CS+/e2 studio project file specified with 
[Template Project] is loaded on start-up. Then, 
a load module is downloaded to the debug tool.  

Template Project *8 
When [Template Project & LM Download] is selected for [IDE Mode], use the 
[Select Template Project] button and specify the CS+ project file name or the 
e2 studio project folder which is used as a template with the absolute path. 

[Select Template Project] 
button *9 

Displays the dialog box to specify the CS+ project file or the e2 studio project 
folder which is used as a template with the absolute path. The selected result 
is reflected to [Template Project]. 

Device Family 

Selects the series name of the microcontroller being used.  

RX 
Selects the RX family as the microcontroller 
series. 

RL78 
Selects the RL78 family as the microcontroller 
series.  

RA *10 *11 
Selects the RA family as the microcontroller 
series. 

FSP Version Specifies version of FSP being used to create RA family project. 

Device Name *12 
Use the [Select Device Name] button to specify the name of the microcontroller 
being used. 

[Select Device Name] 
button *13 

Displays a list of microcontrollers, from which you can select the 
microcontroller that you are using. The selection is reflected in the [Device 
Name] field. 

Byte Order *14 

Selects the Byte Order of the microcontroller being used. 

Little Endian Select the Little Endian as the Byte Order 

Big Endian Select the Big Endian as the Byte Order 

Build Tool *15 

Selecting the Build tool for CS+/e2 studio project, this indicates the compiler 
will be used to generate the load module. 

Renesas Compiler 
Select any of Renesas compilers, which will be 
determined by CS+/e2 studio when creating 
new project.  

GCC ARM Embedded 
Compiler 

Selects any of GCC ARM Embedded compilers, 
which will be determined by e2 studio when 
creating new project for RA devices family. 

[Use Smart Configurator] 
checkbox *26 

When checked 
Create project with Smart Configurator in e2 
studio 

When not checked 
Create project without using Coding Assistant in 
e2 studio 
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GNU ARM Embedded 
Version 

Specifies version of GNU being used to create RA family project 

Project Type *16 *19 

Selects the Project Type. 

Application 
Default value for RX, RL78 device in 
CS+ 

Executable 
Default value for RX, RL78 device in 
e2studio 

Flat (Non-TrustZone®) 

Default value for RA device family in 
e2studio. Select the Flat (Non-
TrustZone®) as the Project Type for 
RA device family 

TrustZone® Secure 
Select the TrustZone® Secure as 
the Project Type for RA device 
family 

TrustZone® Non-Secure 
Select the TrustZone® Non-secure 
as the Project Type for RA device 
family 

Smart Bundle 
*17 *19 

Specifies the absolute path of the Smart Bundle (*.sbd) file of the RA device 
family project. 

[Select Smart Bundle] 
button *18 *19 

Click this button to display the dialog box for selecting the absolute path of the 
Smart Bundle (*.sbd) file. Smart Bundle (*.sbd) file specifications made in the 
dialog box that is opened by this button are reflected in the [Smart Bundle] 
field. 

Debug Tool *20 

Select a Debug Tool and connection type connecting to the target device 

E2 (default) 
Connects to the target device through E2 
Emulator 

E2 Lite 
Connects to the target device through E2 Lite 
Emulator 

COM Port 
Connects to the target device through COM 
Port (For RL78/G23, RL78/G24, RL78/L23) 

Simulator *21 Uses Simulator of the target device 

E20(Serial) 
Connects to the target device through E20 
Emulator with Serial connection. 

E20(JTAG) 
Connects to the target device through E20 
Emulator with JTAG connection. 

EZ_Emulator *22 
Connects to the target device through EZ 
Emulator 

E1(JTAG) 
Connects to the target device through E1 
Emulator with JTAG connection. 

E1(Serial) 
Connects to the target device through E1 
Emulator with Serial connection. 

J-Link 
Connects to the target device through J-Link 
Emulator 

Main Clock Frequency 
(MHz) *23 

Sets main clock frequency of the target device 

Target MCU *24 

Single-Core MCU 

The default target MCU. When this mode is 
selected, the load module generated from the 
Simulink models is executed on one core of the 
target device. 

Multi-Core MCU 
The load module generated from the Simulink 
models is executed on the multiple cores of the 
target device. 
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*1…  When CS+ is selected for [IDE Target], the value of [IDE Install Directory] is changed to the default 

folder where CS+ has been installed, [Workspace Directory] and [e2 studio Support Area] are 

disabled.  

      Otherwise, when e2 studio is selected for [IDE Target], the value of [IDE Install Directory] is changed 

to the default folder where e2 studio has been installed, [Workspace Directory] and [e2 studio 

Support Area] are enabled. 

*2…  When CS+/e2 studio has not been installed in the folder specified with the dialog box 

(CubeSuiteW+.exe/e2studio.exe file does not exist in the specified folder), an error is output, and 

the information of the specified folder is not reflected in [IDE Install Directory]. 

*3…  When the [Use default IDE Install Directory] checkbox is checked, if the [Select IDE Install Directory] 

button is clicked, an error message display. 

*4…  When the [IDE Target] is “CS+”, if the [Select Workspace Directory] button is clicked, an error 

message display. 

[Convert Model for Multi-
Core MCU] button *25 

Generates a file for specifying core to be used for the model conversion for a 
Multicore MCU. A model automatically converted for a Multicore MCU is 
created. 

[Debug Generated Code 
during PIL Simulation] 
checkbox 

When checked 

Measure Execution Time feature is disabled. 

PIL Simulation could be interrupted by User’s 
operation on CS+/e2 studio. 

When not checked 

Measure Execution Time feature can be 
enabled by User. 

PIL Simulation could NOT be interrupted by 
user’s operation on CS+/e2 studio. 

[Measure Execution 
Time] checkbox *21 

When checked 
Execution time is measured in verification of 
algorithm. 

When not checked 
Execution time is not measured in verification 
of algorithm and PIL simulation is performed at 
high speed (default). 

Measurement Method 

Selects the Time Measurement method is being used. 

Performance Function 

The execution time of the load module which 
executes on CS+/e2 studio during the PIL 
Simulation is measured by using Performance 
Function of CS+/e2 studio debug tools. 

This option is set automatically when [Device 
Family] are RL78, RX, RA and [Target MCU] is 
“Single-Core MCU”. 

Software Trace The execution time of the e2 studio load module 
is measured by the debugging function of 
software trace during PIL simulation. This 
option is set automatically when [Device 
Family] is RA, and [Target MCU] is “Multi-Core 
MCU” 

Buffer Size Specifies value of Buffer Size in range 1000 ~ 3000 

[About Embedded 
Target] button 

Displays version information and copyright information of Embedded Target.  
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*5…  To specify [e2 studio Support Area], do the following steps: invoke e2 studio > [Help] > [About e2 

studio] > [Installation Details] to show [e2 studio Installation Details] dialog. In [e2 studio Installation 

Details] dialog, select [Support Folders] tab, you can see the absolute path of “e2 studio support 

area”. 

Figure 3-27. The absolute path of "e2 studio support area" 

*6…  When the [IDE Target] is “CS+”, if the [Select e2 studio Support Area] button is clicked, an error 

message display. 

*7…  When “Open Project” or “Open Project & LM Download” is selected and there is no project file saved 

at the last exit, the default project file is created and then CS+/e2 studio is started as in the case of 

selecting “Create Project”. 

*8…  The setting is only valid if “Template Project & LM Download” is selected for [IDE Mode].  

      Specify the CS+ project file or e2 studio project folder created with Embedded Target. When a CS+ 

project file or e2 studio project folder which has not been created with Embedded Target is 

specified, normal operation is not guaranteed.  

*9…  If this button is clicked while a mode other than “Template Project & LM Download” is selected for 

[IDE Mode], an error occurs.  

*10…  When creating project for RA device family on e2 studio, there is a case that version of FSP or 

GCC ARM Embedded is different with the packages included with e2 studio. If the specified version 

of FSP and GCC ARM Embedded is not correct, the project creation will fail. To specify the correct 

version, modify the value of “FSP Version” or “GNU ARM Embedded Version” in “Embedded Target 

Options”. 

*11...  When using RA device family, only RA6T2 series & RA8T1 series & RA4L1 are supported. 

*12...  If there is no CS+ project file or e2 studio project folder that has been generated at the last exit, 

information that has been specified previously is used to generate the device name. 

*13...  The button is only displayed if “Create Project” is selected for [IDE Mode].  

      The list of the microcontrollers of the series selected with [Device Family] is displayed.  

      If this button is clicked while “Open Project” or “Open Project & LM Download” or “Template Project 

& LM Download” is selected for [IDE Mode], the list is not displayed, and an error occurs. 

*14...  The [Byte Order] list is valid to set when [Device Family] is set to “RX”. 

      The [Byte Order] is set to [Little Endian] and cannot be changed when [Device Family] list is set to 

“RL78” or “RA”. 

*15...  When [Build Tool] is set to “Renesas Compiler” or “GCC ARM Embedded”, the build tool is decided 

by CS+/e2 studio at the project creation time. 

*16…  [Project Type] is enabled only when RA Device Name that supports TrustZone® is selected. In 

other cases, the [Project Type] value will change to the default value on the table above 

automatically. 

*17…  [Smart Bundle] is used only for RA TrustZone® Non-Secure project type, which needs to refer to 

the smart bundle (*.sbd) file of RA TrustZone® Secure project type. So, need to specify [Smart 

Bundle] by smart bundle (*.sbd) file of RA TrustZone® Secure project type to create RA TrustZone® 

Non-Secure project successfully. 

 To specify [Smart Bundle], get (*.sbd) file in RA TrustZone® Non-Secure which have created in 

Section 3.4.1.1Prepare debug configuration for Non-secure with Secure Bundle for RA family. 



Embedded Target V6.10.00  3.   FUNCTIONS 

R20UT5787EJ0100 Rev.1.00  Page 52 of 101 
Feb.01.26   

 

*18…  When the [Device Family] is different from “RA” or [Project Type] is different from “TrustZone® Non-

Secure”, if the [Select Smart Bundle] button is clicked, an error message display. 

*19…  These options are used to support RA TrustZone® project type, which is only available on e2 studio 

2024-07 

*20...  The connection to real target device (LSI device) by any of E1 connection types through Embedded 

Target is same as manual connection on CS+/e2 studio GUI. For effective usage, please create a 

dummy project for the same target on CS+/e2 studio. Then, connect it to the target device through 

available emulator connection types. Once you get success, apply the same emulator connection 

type and Main Clock Frequency value to Embedded Target for PIL Simulation. 

      COM Port only supports RL78/G23, RL78/G24, RL78/L23 series. 

J-Link supports RA device family and some devices of RX and it can be used if [IDE Target] is e2 

studio. 

RL78/F25, RL78/F22 only supports on CS+ V8.14.00 or later with these debug tools: E2, E2 Lite, 

Simulator. 

      This list is available to set when [Device Family] list is set to “RX” or “RL78” or “RA” and [IDE Mode] 

is set to “Create Project”. 

      The default E2 Emulator type will be used in corresponding CS+/e2 studio packages. 

*21…  [Measure Execution Time] does not support some cases. Refer to "1.3 Can not support measuring 

execution time” in RESTRICTIONS. 

*22…  EZ emulator will not support RX device family on CS+ V8.09.00 / e2 studio 2023-01 and later. 

*23…  This textbox is valid for changing when [Debug Tool] list is set to any of “E1(JTAG/Serial)/E2/E2 

Lite/E20 (JTAG/Serial)/EZ” connection types. 

*24…  [Target MCU] is enabled only when RA Device Name that supports multi-core is selected. In other 

cases, the [Target MCU] value will change to the default value on the table above automatically. 

*25…  When the [Device Family] is different from “RA” or [Device Name] is different from “RA8 Multi-Core 

devices” or [FSP Version] is “5.7.0” (or lower) or [Target MCU] is different from “Multi-Core MCU”, if 

the [Convert Model for Multi-Core MCU] button is clicked, an error message display. 

*26…  The [Use Smart Configurator] option is valid to set when [IDE Target] is “e2 studio” and [Device 

Family] is set to “RX”. 

Remark When directly entering the installation directory path for each tool: 

  1. “¥” must not be used. Use “/” instead. 

  2. Do not let the “/” symbol at the end of installation directory path. 

 

6. Close the Configuration Parameters dialog box. 

Check the settings and then click the [OK] button.  
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3.4.1.4 Generating a test environment 

This section explains how to execute generation of the test environment required for PIL simulation when using 

a Subsystem block. 

Embedded Target provides the following command, which can be used in the MATLAB® command window. 

When a Subsystem block is used, this command automatically executes a series of operations for generation 

of a test environment. 

Table 3.4-3. Provided Command 

Command name Description 

ecpils_build Generates a test environment (only when a Subsystem block is used) 

There is only way to execute generation of a test environment.  

Select a Subsystem block in the DataTypes window and then use the following method to execute generation 

of a test environment. 

Execute generation from the command window. 

Execute generation of a test environment by entering the ecpils_build command provided by Embedded Target 

in the MATLAB® command window, using the following syntax.  

Here ">>" denotes the command prompt and "[Enter]" denotes entry of the Enter key. 

 

Remarks 

When executing generation of a test environment by using this method, the following operations are also carried 

out. Therefore, it is not necessary to perform the operation described in section “Replacing blocks for PIL 

sequential execution for PIL simulation”. 

The model file, including the selected Subsystem block, is copied (the destination model file has the same name 

as the original model file but "_ecpils" suffix is added). 

The Subsystem block is replaced with the block for PIL sequential execution for the model file to be copied. 

Save the modified model file before execution of ecpils_build command. 

  

 

>> ecpils_build [Enter] 
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3.4.1.5 Replacing blocks for PIL sequential execution for PIL simulation 

When generation of a test environment is carried out from the MATLAB® command window, block replacement 

is carried out as a series of operations for generating a test environment. Accordingly, explicit operation by the 

user is not necessary. 

The following explains how to replace blocks when generation of a test environment is carried out from the 

DataTypes window. In this case, this operation must be performed by the user.  

• How to replace blocks 

Delete the Subsystem block "DataTypes" in the DataTypes window and then drag the block for PIL 

sequential execution "DataTypes” from the untitled window and drop it in the corresponding position in the 

DataTypes window. This generates the PIL simulation model.  

 

Figure 3-28. Replacing a Block for PIL Sequential Execution 

Remarks 1. After blocks for PIL sequential execution have been generated, the block for PIL sequential 

execution created on the untitled model file is replaced with the Subsystem of the base model. 

The untitled model can be closed without being saved. 

   2. Multiple blocks for PIL sequential execution cannot be assigned in the model. 

  



Embedded Target V6.10.00  3.   FUNCTIONS 

R20UT5787EJ0100 Rev.1.00  Page 55 of 101 
Feb.01.26   

 

3.4.1.6 Generating a load module 

When “Open Project & LM Download” or “Template Project & LM Download” is set for [IDE Mode] in the 

[Embedded Target Options] of the Configuration Parameters dialog box, generation and downloading of a load 

module is carried out automatically as a series of the operations for generating a test environment. Accordingly, 

explicit operation by the user is not necessary.  

When “Create Project” is set for [IDE Mode] in the [Embedded Target Options] of the Configuration Parameters 

dialog box, on the first generate, please wait until the successful project creation dialog appears as shown 

below. 

 

The following explains how to generate a load module when [Create Project] or [Open Project] is set for [IDE 

Mode]. 

• How to generate a load module 

[When using CS+ IDE] 

(1) Make option settings for a build tool (such as compiler and assembler) in the Property panel of CS+. 

Note that the default settings of CS+ should be changed in the following cases. 

[When using big endian in RX] 

Select [Build Tool] in the CS+ project tree and set [Big-endian data (-endian=big)] for [Common 

Options] - [CPU] - [Endian type for data]. 

Here, a message dialog box saying, “Also change the endianness of the debug tool?” appears. Select 

“Yes”. 

[When using RL78] 

Select [Build Tool] in the CS+ project tree and set value for (*) [Compile Options] – [Output Code] – 

[Process double type / long double type as float type] to “No(-dbl_size=8)”. And set value for [Link 

Options] – [Device] – [Option byte values for OCD] and [User option byte value]. And set [Yes 

(Specify address range) (-DEBUG_MONITOR=<Address range>)] for [Link Options] – [Device] – [Set 

debug monitor area]. These values are described in user’s hardware manual of each device family. 

If [Debug Generated Code during PIL Simulation] in [Configuration Parameter] – [Embedded Target 

Options] is checked, set value for [Compile Options] – [Optimization (Details)] - [Perform inline 

expansion] to “No(-Oinline_level=0)”. 

(*): Only set this option when device is RL78 S3-core and use higher 2-bytes data type. 

(2) Save the CS+ project. 

(3) Select [Build Project] from the [Build] menu of CS+. 

  

Figure 3-29. Successful project creation dialog 
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[When using e2 studio IDE] 

(1) Make option settings for a build tool in the Property panel of e2 studio. 

[When using RL78 in e2 studio IDE] 

Right click to project choose [Properties], select [C/C++ Build] > [Settings] to open Setting dialog of 

Build Tool. In [Compiler] – [Output Code], uncheck for (*) [Process double type / long double type as 

float type (-dbl_size)]. In [Linker] – [Device], check and set value for [Set user option byte (-

user_opt_byte)], [Set enable/disable on-chip debug byte link option (-ocdbg)] and [Secure memory 

area of OCD monitor (-debug_monitor)]. These values are described in user’s hardware manual of 

each device family. 

If [Debug Generated Code during PIL Simulation] in [Configuration Parameter] – [Embedded Target 

Options] is checked, set value for [Compiler] – [Optimization] - [Perform inline expansion (-

Oinline_level)] to “No”. 

 

[When using RA8 device series on e2 studio IDE] 

To ensure the clock matches with the device, please follow these steps. If use RA8 Multi-Core, only 

setting for cpu0 ‘s project: 

(1)  Double click “configuration.xml” in [Project Explorer] panel to open “FSP Configuration”. 

(2)  Click [BSP] tab → [Board] → [Device]. Choose the appropriate board and device. 

(3)  Press [Generate Project Content]. 

 

(*): Only uncheck this option when device is RL78 S3-core and use higher 2-bytes data type. 

 

(2) Build the project by one of the below ways: 

• Right click on the project and select [Build Project] 

• Click on the project to set focus and select [Project] → [Build Project] 

• Click on the project to set focus and click on  icon 

• Click on the project to set focus and press [Ctrl] + [B] 

Remark For details on generating the load module, refer to “Build” of CS+/e2 studio User’s Manual. 

 

3.4.1.7 Downloading a load module 

When “Open Project & LM Download” or “Template Project & LM Download” is set for [IDE Mode] in the 

[Embedded Target Options] of the Configuration Parameters dialog box, downloading of a load module is carried 

out automatically as a part of a series of the operations for generating a test environment. Accordingly, explicit 

operation by the user is not necessary.  

The following describes how to make settings for a debug tool and how to download a load module when “Create 

Project” or “Open Project” is set for [IDE Mode]. 

1. For Single-Core project: 

•  How to make settings for a debug tool 

[When using E1/E2/E2 Lite/E20 (JTAG/Serial)/EZ Emulator or COM Port with RX, RL78 families on CS+ 

IDE] 

Select [Debug Tool] in the CS+ project tree and select [Yes] for [Debug Tool Settings] - [Access Memory 

While Running] - [Access during execution] (or [Access by stopping execution]) in property setting. 

[When using Big Endian in E2/E2 Lite/E20 (JTAG/Serial)/EZ Emulator with RX families on e2 studio IDE] 
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(1) Click “Tutorial” project in [Project Explorer] panel to set focus 

(2) Click [Run] → [Debug Configurations...] or  icon (downward arrow) → [Debug Configurations...] to 

open the “Debug Configurations” window. 

(3) In “Debug Configurations” window, go to [Renesas GDB Hardware Debugging] → [Tutorial 

HardwareDebug]. Switch to the [Debugger] tab. 

Under the [Debugger] tab, go to the [Debug Tool Settings] sub tab, select [Big Endian] for [Memory] – 

[Endian]. 

 

•  How to download a load module  

[When using CS+ IDE] 

Make option settings for a debug tool (E1/E2/E2 Lite/E20 (JTAG/Serial)/EZ/J-Link Emulator or COM Port or 

a simulator) with the property panel of CS+ and then download a load module by selecting [Download] from 

the [Debug] menu of CS+. 

 

Figure 3-30. CS+ on Completion of Downloading to the Debugger 
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[When using e2 studio IDE] 

Click the target project in [Project Explorer] panel to set focus and click icon to launch a debugger 

session and then download a load module. 

 

Figure 3-31. e2 studio on Completion of Downloading to the Debugger 

 

2. For Multi-Core project: 

Click [Debug Configurations…] on toolbar. 

 

 

 

 

 

 

  

Figure 3-32. Debug Configurations 
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For E2/E2 Lite debug tool: Select [Renesas GDB Hardware Debugging] tab Choose pre-created launch in 

the format “<Model Name>_multicore_CPU1 Debug_Multicore” Click [Debug]. 

  

Figure 3-33. Multi-Core Debug Launch Group (E2/E2 Lite) 
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For J-Link debug tool: Select [Launch Group] tab Choose pre-created launch group in the format “<Model 

Name>_multicore_CPU1 Debug_Multicore” Click [Debug]. 

  

Figure 3-34. Multi-Core Debug Launch Group (J-Link) 
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3.4.2 Executing PIL Simulation 

The following explains how to run PIL simulation when generation of a test environment is carried out from the 

DataTypes window. 

• How to execute PIL simulation 

Verify that the information in the DataTypes window has changed to that of the PIL simulation model. Then 

select [Run] from the [Simulation] menu to start PIL simulation. 

 

Figure 3-35. PIL Simulation Executions 

Remark If you save the model file after executing this operation, the original model file is overwritten. 

The following confirmation dialog box is displayed until Embedded Target confirms that downloading is 

completed. The dialog box is closed automatically after completion of download. To stop downloading and 

suspend a series of operations, click the OK button in the dialog box. 

 

Figure 3-36. Confirmation Dialog Box 
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3.4.3 Debugging Generated Code during PIL Simulation 

This section describes how to debug generated code from embedded models during PIL Simulation. In this, you 

can use all debugging features offered by CS+/e2 studio’s Debug Tools such as: 

• Step 1: Open model, select Code Generation Target Subsystem and open Model Configuration 

Parameters window. 

• Step 2: Setting all necessary conditions and check the [Debug Generated Code during PIL Simulation] 

checkbox. 

• Step 3: Save model and execute MATLAB® command: “>> ecpils_build [Enter]” 

• Step 4: Build and Download CS+/e2 studio project. There are two breakpoints that set at main() and 

ecpils_synchronize_Simulink() functions of “ecpils_main.c” file automatically (in multi-core project, only 

cpu0 ‘s project is set). 

• Step 5: Hit [Run] button in Simulink® Model and start debugging: 

⎯ Step-by-step go through each instruction 

⎯ Step into a code block, function 

⎯ Stop CPU 

⎯ Etc. 

To enable this mode, please check the [Debug Generated Code during PIL Simulation] during the Setting 

configuration parameters procedure. Bellow figure shows sample of setting on Embedded Target Options GUI: 

 

 

Figure 3-37. Enable Debug Generated Code during PIL Simulation 
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Figure 3-38. Two automatic breakpoints in “ecpils_main.c” file in CS+ 

 

Figure 3-39. Two automatic breakpoints in “ecpils_main.c” file in e2 studio 
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Remarks 1. When using this function, you cannot measure the execution time. As a result, the [Measure 

Execution Time] checkbox is disabled. 

2. The timeout for debugging 1 step is 24 hours as maximum. When the timeout exceeds, PIL 

Simulation process is stopped. 

3. When the program on target side (CS+/e2 studio) is stopped. The Simulink® GUI is also 

frozen, it means cannot pause or stop the Simulation on the Simulink® GUI. This is a limitation 

of MATLAB®/Simulink®. To stop the PIL Simulation, remove breakpoints (if added) in the 

debugging process, then let the code run through and finish the Simulation.  

4. Do not disconnect the Debug Tool or end the CS+/e2 studio process during debugging. This 

will cause unexpected behaviors. 

5. Do not change the workflow of PIL Simulation on the CS+/e2 studio side such as: modify    

Embedded Target generated code, change value of Program Counter, etc., such actions make 

PIL Simulation process operate abnormally, and some error may display. 

6. When using this function with RL78 device family, setting for [Perform inline expansion] follow 

3.4.1.6 Generating a load module. 

3.4.4 Re-executing Embedded Target 

Re-execute Embedded Target with either of the following steps. 

• Using the ecpils_build command (when the Simulink® model is updated or code generation is re-executed) 

(1) Terminate the <model name>_ecpils.slx window, of which model is for Simulink® and has been 

previously executed and CS+/e2 studio. 

(2) Remove the slprj folder that has been generated at last execution. 

(3) Run the ecpils_build command in the MATLAB® command window. 

(4) Run simulation from the Simulink® window. 

• PIL simulation only (when the Simulink® model is not updated and code generation is omitted) 

(1) Exit the <model name>_ecpils.slx window, of which model is for Simulink® and has been last 

executed and CS+/e2 studio. 

(2) Start the <model name>_ecpils.slx window and run simulation. 

(3) CS+/e2 studio is started. When [Create Project] or [Open Project] is set for [IDE Mode] of [Embedded 

Target Options] in the Configuration dialog box, start downloading. 

(4) When CS+/e2 studio finished downloading, PIL simulation is automatically started. 

3.4.5 Cleanup Embedded Target workspace after PIL Simulation 

Cleanup Embedded Target workspace with either of the following steps: 

• Manually delete the following folders and files or using "ecpils_cleanup" command for automatic clean up 

(if necessary): 

⎯ Folders: +ecpils, < ModelName >_ecpils, slprj 

⎯ Model: < ModelName >_ecpils.slx 

⎯ Source Code with suffix _Launch_GraphViewer.m 

⎯ Source Code with suffix _Convert_Measurement_Data.m 

⎯ Files with suffix _Total_Time.csv, _Worst_Time.csv 
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3.5 Executing PIL Simulation for Reference Code Generation Target Model 

The following describes how to generate a test environment necessary for PIL simulation when the target for 

code generation is a reference model. 

3.5.1 Generating a Test Environment 

This section explains how to generate a test environment necessary for PIL simulation.  

The explanation uses sample models DataTypesReference.slx and DataTypesRef.slx provided with Embedded 

Target. In case of run PIL Simulation with RA8 Multi-Core, refer chapter 3.2.1 Procedure for Manually Specifying 

Core Targets (Multi-Core MCU) to how to convert multi-core model.  

3.5.1.1 Prepare debug configuration for Non-secure with Secure Bundle for RA family 

Refers to Section 3.4.1.1 Prepare debug configuration for Non-secure with Secure Bundle for RA family. 

3.5.1.2 Preparing a model using a reference model 

Use sample models DataTypesReference.slx and DataTypesRef.slx.  

DataTypesReference.slx references DataTypesRef.slx. DataTypesRef.slx is not directly used. 

3.5.1.3 Setting configuration parameters 

Embedded Target checks or sets options for code generation. The same settings must be made by a set of 

DataTypesReference.slx and DataTypesRef.slx. 

1. Open the Configuration Parameters dialog box 

Select [Model Configuration Parameters] from the [Simulation] menu in the DataTypesReference window 

to open the Configuration Parameters dialog box. 

2. Set [Hardware Implementation] options 

Select [Hardware Implementation] in the [Select] area and make the settings described below. Then click 

the [Apply] button.  
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Figure 3-40. [Hardware Implementation] Options  



Embedded Target V6.10.00  3.   FUNCTIONS 

R20UT5787EJ0100 Rev.1.00  Page 67 of 101 
Feb.01.26   

 

Remark 1. Device type value in [Hardware Implementation] panel can be changed by setting Device 

Family value in [Embedded Target Options] panel. The change goes into effect when pressing 

“OK” or “Apply” button on [Embedded Target Options] panel. 

2. The setting of Device Family value is enabled when IDE Mode value is [Create Project] value 

in [Embedded Target Options] panel. 

3. Set [Model Referencing] options 

Select [Model Referencing] in the [Select] area. Then make the setting of [Rebuild] and click the [Apply] 

button.  

When [Always] is selected, code generation is performed regardless of the change of the Simulink® model. 

However, when [If any changes detected] or [If any changes in known dependencies detected] is selected 

and the change of the Simulink® model is not detected, code generation is omitted. Note that [Never] must 

not be set. 

  

Figure 3-41. [Model Referencing] Options 
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4. Set [Code Generation] options 

Select [Code Generation] in the [Select] area. Then make the settings shown in the figure below and click 

the [Apply] button. 

 

Figure 3-42. [Code Generation] Options 

Remark The template make file (ecpils.tmf) will be overwritten according to selected Mex compiler 

(>>mex -setup). 
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5. Set [SIL and PIL Verification] or [Verification] options 

Figure 3-43. [Verification] Options 

6. Set [Embedded Target Options] 

Use the same setting as when a Subsystem block is used. Refer to section “Setting configuration 

parameters ” /” 5 Set [Embedded Target Options]”. 

7. Close the Configuration Parameters dialog box 

Check the settings and then click the [OK] button. 

8. Set the configuration parameters for the DataTypesRef model 

Double-click the target Model block for code generation and open the DataTypesRef window. 

Select [Code Generation] - [Options] from the [Tools] menu in the DataTypesRef window and then make 

the same settings described in procedures (2) to (6). 
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3.5.1.4 Specifying PIL mode 

Specify the PIL mode for the target model for code generation. 

1. Open the Function Block Parameters dialog box 

Select the target Model block for code generation and right-click it to select [Block Parameters 

(ModelReference)]. Then the Function Block Parameters dialog box will open. 

   

Figure 3-44. Function Block Parameters Dialog Box 

2.  Select PIL mode 

Select Processor-in-the-loop (PIL) as a Simulation mode. 

3.5.1.5 Executing PIL Simulation 

Verify that the information in the DataTypesReference window has changed to that of the PIL simulation model. 

Then select [Run] from the [Simulation] menu to start PIL simulation. Code generation and start-up of CS+/e2 

studio are performed in preparation for PIL simulation. 

Figure 3-45. PIL Simulation Executions  
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Remark  If code generation is performed after this operation, CS+/e2 studio is started. The storage file 

for execution time measurement result will be removed. 

3.5.1.6 Generating a load module 

The steps of Generating a load module for Reference model are the same as the steps of generating for 

Subsystem block. Refer to section “Generating a load module”. 

3.5.1.7 Downloading a load module 

CS+/e2 studio is started up. When “Create Project” or “Open Project” is set for [IDE Mode] in the [Embedded 

Target Options] of the Configuration dialog box, build and download a load module by following the procedure. 

When “Open Project & LM Download” or “Template Project & LM Download” is set, a load module is built and 

downloaded to the debugger automatically. PIL simulation starts on completion of downloading. 

1. For Single-Core project: 

•  How to make settings for a debug tool 

[When using E1/E2/E2 Lite/E20 (JTAG/Serial)/EZ Emulator or COM Port with RX, RL78 families on CS+ 

IDE] 

Select [Debug Tool] in the CS+ project tree and select [Yes] for [Debug Tool Settings] - [Access Memory 

While Running] - [Access during execution] (or [Access by stopping execution]) in property setting. 

[When using Big Endian in E2/E2 Lite/E20 (JTAG/Serial)/EZ Emulator with RX families on e2 studio IDE] 

(1) Click “Tutorial” project in [Project Explorer] panel to set focus 

(2) Click [Run] → [Debug Configurations...] or  icon (downward arrow) → [Debug Configurations...] to 

open the “Debug Configurations” window. 

(3) In “Debug Configurations” Windows®, go to [Renesas GDB Hardware Debugging] → [Tutorial 

HardwareDebug]. Switch to the [Debugger] tab. 

Under the [Debugger] tab, go to the [Debug Tool Settings] sub tab, select [Big Endian] for [Memory] – 

[Endian]. 

•  How to download a load module  

[When using CS+ IDE] 

Make option settings for a debug tool (E1/E2/E2 Lite/E20 (JTAG/Serial)/EZ Emulator or COM Port or a 

simulator) with the property panel of CS+ and then download a load module by selecting [Download] from 

the [Debug] menu of CS+. 
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Figure 3-46. CS+ on Completion of Downloading to the Debugger 

[When using e2 studio IDE] 

Click the target project in [Project Explorer] panel to set focus and click  icon to launch a debugger 

session and then download a load module. 

 

Figure 3-47. e2 studio on Completion of Downloading to the Debugger 
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2. For Multi-Core project: 

Click [Debug Configurations…] on toolbar. 

 

 

 

 

 

 

For E2/E2 Lite debug tool: Select [Renesas GDB Hardware Debugging] tab   Choose pre-created launch 

in the format “<Model Name>_multicore_CPU1 Debug_Multicore”   Click [Debug]. 

  

Figure 3-48. Debug Configuration 

Figure 3-49. Multi-Core Debug Launch Group (E2/E2 Lite) 
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For J-Link debug tool: Select [Launch Group] tab → Choose pre-created launch group in the format “<Model 

Name>_multicore_CPU1 Debug_Multicore” → Click [Debug]. 

 
Figure 3-50 Multi-Core Debug Launch Group (J-Link) 

The following confirmation dialog box is displayed until Embedded Target confirms that downloading is 

completed. The dialog box is closed automatically after completion of downloading. To stop downloading and 

suspend a series of operations, click the OK button in the dialog box. 

 

Figure 3-51. Confirmation Dialog Box 
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3.5.2 Debugging Generated Code during PIL Simulation 

This section describes how to debug generated code from embedded models during PIL Simulation. In this, you 

can use all debugging features offered by CS+/e2 studio’s Debug Tools such as: 

• Step 1: Open model, select Code Generation Target Subsystem and open Model Configuration 

Parameters Window. 

• Step 2: Setting all necessary conditions and check the [Debug Generated Code during PIL Simulation] 

checkbox (setting for both Reference and Ref models). 

• Step 3: Save model and hit [Run] button in Simulink® Model. 

• Step 4: Build and Download CS+/e2 studio project. There are two breakpoints that set at main() and 

ecpils_synchronize_Simulink() functions of “ecpils_main.c” file automatically (in multi-core project, only 

cpu0 ‘s project is set). 

• Step 5: Start debugging: 

⎯ Step-by-step go through each instruction 

⎯ Step into a code block, function 

⎯ Stop CPU 

⎯ Etc. 

To enable this mode, please check the [Debug Generated Code during PIL Simulation] during the setting 

configuration parameters procedure. Below figure shows sample of setting on Embedded Target Options GUI: 

 

Figure 3-52. Enable Debug Generated Code during PIL Simulation  
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Figure 3-53. Two automatic breakpoints in “ecpils_main.c” file 

 

Figure 3-54. Two automatic breakpoints in “ecpils_main.c” file in e2 studio 
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Remarks 1. When using this function, you cannot measure the execution time. As a result, the [Measure 

Execution Time] checkbox is disabled. 

 2. The timeout for debugging 1 step is 24 hours as maximum. When the timeout exceeds, PIL 

Simulation process is stopped. 

 3. When the program on target side (CS+/e2 studio) is stopped. The Simulink® GUI is also 

frozen, it means cannot pause or stop the Simulation on the Simulink® GUI. This is a limitation 

of MATLAB®/Simulink®. To stop the PIL Simulation, remove breakpoints (if added) in the 

debugging process, then let the code run through and finish the Simulation.  

 4. Do not disconnect the Debug Tool or end the CS+/e2 studio process during debugging. This 

will cause unexpected behaviors. 

5. Do not change the workflow of PIL Simulation on the CS+/e2 studio side such as: modify 

Embedded Target generated code, change value of Program Counter, etc., such actions make 

PIL Simulation process operate abnormally, and some error may display. 

6. When using this function with RL78 device family, setting for [Perform inline expansion] follow 

3.4.1.6 Generating a load module. 

3.5.3 Re-executing Embedded Target 

Terminate the Simulink® model previously executed and CS+/e2 studio. Then, start the Simulink® model and 

run simulation. 

Operation differs according to the setting of [Rebuild] for [Model Referencing] in the Configuration dialog box. 

When [Always] is set, code generation is performed. When [If any changes detected] or [If any changes in known 

dependencies detected] is set, code generation is omitted if the Simulink® model is not updated.  

3.5.4 Cleanup Embedded Target workspace after PIL Simulation 

Cleanup Embedded Target workspace with either of the following steps: 

• Manually delete the following folders and files or using "ecpils_cleanup" command for automatic clean up 

(if necessary): 

⎯ Folders: +ecpils, slprj 

⎯ Source Code with suffix _Launch_GraphViewer.m 

⎯ Source Code with suffix _Convert_Measurement_Data.m 

⎯ Files with suffix _Total_Time.csv, _Worst_Time.csv 
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3.6 Executing PIL Simulation for Top-level Code Generation Target Model 

The following describes how to generate a test environment necessary for PIL simulation when the target for 

code generation is a top-level model. 

3.6.1 Generating a Test Environment 

This section explains how to generate a test environment necessary for PIL simulation.  

The explanation uses a sample model DataTypesRef_Top.slx provided with Embedded Target. In case of run 

PIL Simulation with RA8 Multi-Core, refer chapter 3.2.1 Procedure for Manually Specifying Core Targets (Multi-

Core MCU) to how to convert multi-core model. 

3.6.1.1 Prepare debug configuration for Non-secure with Secure Bundle for RA family 

Refers to Section 3.4.1.1 Prepare debug configuration for Non-secure with Secure Bundle for RA family. 

3.6.1.2 Preparing a model using a top-level model 

Use a sample model DataTypesRef_Top.slx. 

3.6.1.3 Setting configuration parameters 

Use the same setting as when a Subsystem block is used. Refer to section “Setting configuration parameters”. 

3.6.1.4 Specifying PIL mode 

Specify the PIL mode for the target model for code generation. 

1. Select Processor-in-the-loop (PIL) mode 

Select [App] – [SIL/PIL Manager] and select [Processor-in-the-Loop (PIL)] from the [SIL/PIL] menu window. 

  

Figure 3-55. Simulation Menus for MATLAB® R2022b and above 

2. Set a parameter 

Set a parameter of the model and a workspace variable. The .m file that is used to set a workspace 

variable is prepared in a sample model. 
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3.6.1.5 Executing PIL Simulation 

Verify that the information in the DataTypesRef_Top window has changed to that of the PIL simulation model 

and that a workspace variable has been set. Then select [Run] from the [SIL/PIL] menu to start PIL simulation. 

Code generation and start-up of CS+/e2 studio are performed in preparation for PIL simulation. 

 

Figure 3-56. PIL Simulation Executions for MATLAB® R2022b and above 

Remark  If code generation is performed after this operation, CS+/e2 studio is started. The storage file 

for execution time measurement result will be removed. 

3.6.1.6 Generating a load module 

The steps of Generating a load module for Top-level model are the same as the steps of Generating a load 

module for Subsystem block. Refer to section 3.4.1.6 Generating a load module. 

3.6.1.7 Downloading a load module 

The steps of Downloading a load module during PIL Simulation used for Top-level model are the same as the 

steps of downloading used for Reference model. Refer to section 3.5.1.7 Downloading a load module. 

3.6.2 Debugging Generated Code during PIL Simulation 

The steps of Debugging Generated Code during PIL Simulation used for Top-level model are the same as the 

steps of debugging used for Reference model. Refer to section 3.5.2 Debugging Generated Code during PIL 

Simulation. 

3.6.3 Re-executing Embedded Target 

Terminate the Simulink® model previously executed and CS+/e2 studio. Then, start the Simulink® model and 

run simulation. 

When the Simulink® model is not updated and Embedded Target is re-executed, code generation is omitted. 

When the Simulink® model is updated, code generation is not omitted. 
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3.6.4 Cleanup Embedded Target workspace after PIL Simulation 

Cleanup Embedded Target workspace with either of the following steps: 

• Manually delete the following folders and files or using "ecpils_cleanup" command for automatic clean up(if 

necessary): 

⎯ Folders: +ecpils, < ModelName >_ecpils, slprj 

⎯ Source Code with suffix _Launch_GraphViewer.m 

⎯ Source Code with suffix _Convert_Measurement_Data.m 

⎯ Files with suffix _Total_Time.csv, _Worst_Time.csv 
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3.7 Verifying Algorithms of Code Generation Targets 

You can use information (execution time of a load module generated from the embedded model and result of 

execution) obtained by running a PIL Simulation to verify algorithms.  

The execution time measurement exported only when the [Measure Execution Time] checkbox is selected in 

[Embedded Target Options] of the Configuration Parameters dialog box.  

Depending on the PIL Simulation mode and Time Measurement method, the procedures to get the execution 

time might be different. Refer to the blow sections in accordance with the PIL Simulation modes and Time 

Measurement methods for details. 

Remark 1.  Time Measurement by Performance Function can be used only on Single-Core PIL 

Simulation with all supported MCU families. 

2.  Time Measurement using Performance Function supplies the execution time which is 

measured by using the timer function provided by CS+/e2 studio. Therefore, before measuring 

execution time with a debug tool, the timer function must be turned on. You can turn the timer 

function on and off by clicking the [Timer] button on the right side of the CS+/e2 studio status 

bar. 

3.  The execution time measurement result is in nanosecond (ns) unit. 

3.7.1 Time Measurement with Performance Function method 

The following sections describe the Time Measurement with Performance Function method. This supplies the 

total execution time of the whole PIL Simulation process and can be used on Single-Core PIL Simulation only. 

To enable this feature, check the [Measure Execution Time] checkbox, set [Measurement Method] selection list 

to “Performance Function”. 

The measurement result is stored in the following files in according to code generation target: 

1. When Code Generation Target is a Subsystem Block 

Storage file for execution time measurement result of 
Subsystem Code Generation Target Block 

<directory containing the model> \<Subsystem name>_ecpils\ <Subsystem name>.txt 

2. When Code Generation Target is a Reference Model 

Storage file for execution time measurement result of 
Reference Code Generation Target Model 

<directory containing model> \slprj\ecpils\<reference model name>\<reference model name>.txt 

 

3. When Code Generation Target is a Top-level Model 

Storage file for execution time measurement result of 
Top-level Code Generation Target Model 

<directory containing model>\<top-level model name>_ecpils\<top-level model name>.txt 

4. The measurement result is stored in the following format 
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Normal case Total: <total execution time>ns, Pass Count: <pass 
count>, Average: <average execution time>ns, 

Max: <maximum execution time>ns, Min: 
<minimum execution time>ns 

An overflow has occurred when measuring the 
execution time of each step 

Total: Overflow, Pass Count: <pass count>, 
Average: N/A, Max: N/A, Min: <minimum execution 

time>ns 

An overflow has occurred when calculating the 
total execution time 

Total: Overflow, Pass Count: <pass count>, 
Average: N/A, Max: <maximum execution time>ns, 

Min: <minimum execution time>ns 
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3.7.2 Time Measurement with Software Trace method 

The following sections describe features offered by the Time Measurement with Software Trace method, which 

can be used on RA Multi-Core MCU. 

The Time Measurement with Software Trace method allows measuring the execution time of each Subsystem 

block. Particularly, for Multi-Core MCU, the Software Trace also supplies the waiting time of allocated blocks for 

synchronization with processes of other blocks which are allocated to different cores. In additional, Subsystem 

blocks which are target for this Time Measurement method must be allocated. Therefore, it requires the Simulink 

Model to be converted for additional configurations refer to section 3.2.1 Procedure for Manually Specifying 

Core Targets (Multi-Core MCU). 

To enable this feature, check the [Measure Execution Time] checkbox. To get measured result, you can use 

either 3 of the following methods (All related files are put in <Model Location> folder): 

• Visual display on MATLAB plot: execute the script named 

➢ For Subsystem model: 

Execute script <BlockName>_Convert_Measurement_Data.m to convert data to right format. 

Execute script <BlockName>_<TargetMCU>_Launch_GraphViewer.m to show Execution Time 

Graph Viewer GUI. 

➢ For Reference model and Top model: 

Execute script <ModelName>_Convert_Measurement_Data.m to convert data to right format. 

Execute script <ModelName>_<TargetMCU>_Launch_GraphViewer.m to show Execution 

Time Graph Viewer GUI. 

 

 

 

Figure 3-57. Execution Time Graph Viewer GUI 
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• Concrete execution time of step which has worst result: open the file named 

“<Code Generation Target Subsystem Name>_ Worst_Time.csv”. 

• Concrete execution time of all steps in PIL Simulation: open the file named 

“<Code Generation Target Subsystem Name>_ Total_Time.csv”. 

 

The Execution Time Graph Viewer shows the simulation time summary of Scheduler, Execution time of Single-

Core or Multi-Core. Scheduler time indicates period time for controlling source code (none core running), Core 

executing indicates period time of one core executing or multiple cores executing.Users can perform some other 

functions as follows: 

• Change scale of step by press [Change Scale] button then set “Start Step” and “End Step” (e.g., Start 

Step = 1, End Step = 5). 

 

 

 

 

Figure 3-59. Set “Start Step” and “End Step” value  

Figure 3-58. Press [Change Scale] to change scale of step  
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Then press [OK] to shows Simulations time Summary from “Start Step” to “End Step” the result like 

 

 

• Press [Show Step Graph] to shows execution time of each Subsystem for one step or more steps belong 

to user choose in “Start Step” and “End Steps” and there are two options, depending on the core or 

rate. 

 

 

 

 

Figure 3-60. Visual execution time result of Simulation Time Summary 

Figure 3-61. Press [Show Step Graph] to show execution time each Subsystem 
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Then Set “Start Step” and “End Step” 

 

 

 

 
 
  

Figure 3-62. Set value Start Step, End Step and Options to show execution time 
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If depending on the core set “Options” is “DependArrows = annotation Coloring = CPU”, if depending on the 

rate set “Options” is “DependArrows = annotation Coloring = rate”. Then press [OK] the result like 

NOTE: If the “Start Step” and “End Step” are the same step which does not have data. The empty graph 

will display 

• Press [MAX/min] to shows which steps has the maximum execution time and minimum execution time. 

 

  

Figure 3-63. Execution Time Detail from step 1 to step 5 depending on core 

Figure 3-64. Show Max/Min execution time 
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Then the Max Min Dialog show step has execution time maximum/minimum and the value of execution time of 

this step. Press [Show step graph] in Maximum/Minimum Section to shows execution time detail of this step. 

 

 

Figure 3-65. Max/min Dialog 
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   ERROR MESSAGES 

This chapter explains the error messages output by Embedded Target. 

4.1 Overview 

Error messages are output to notify you of information that you should know about events that occur while you 

are setting [Embedded Target Options] in the Configuration Parameters dialog box or while a PIL simulation is 

running.  

Remark Error messages output by Embedded Target are not linked to CS+/e2 studio. Therefore, no help 

is displayed even if you press the F1 key after Embedded Target displays an error message.  

4.2 Errors Detected in Configuration Parameters Dialog Box 

The following table lists the messages that are output when an error is detected while settings are being made 

in the Configuration Parameters dialog box.  

These error messages are output to the Embedded Target Error dialog box. 

 

Table 4-1. Error Messages for Configuration Parameters Dialog Box 

[Message] E0101 

The <Embedded Target option> is invalid. Please check the entered value. 

[Explanation] This error message is displayed when value of an option is entered incorrectly. 

[Action by User] Specify the correct value for options that have type are edit box. 

[Message] E0102 

This button cannot currently be pressed. Please change the value of <Embedded 
Target option>. 

[Explanation] This error message is displayed when a button cannot be pressed because the value 
of the option indicated in the error message does not match. 

[Action by User] Change the value of the option indicated in the error message. 

[Message] E0104 

An incorrect automation server is registered. 

[Explanation] This error message is displayed if a different version of MATLAB is registered as the 
automation server.  

[Action by User] Register the MATLAB in use as the automation server using the “regmatlabserver” 
command.  
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[Message] E0106 

The selected debug tool is not supported. Please choose another debug tool. 

[Explanation] This error message displayed when selected Debug Tool is not supported by device 
family or device name.  

[Action by User] Select another debug tool corresponding to the value of [Device Family] option and 

[Device Name] option. 

[Message] E0109 

The model conversion mode does not match <Target MCU>. 

[Explanation] This error message is displayed when the MCU type set in [Target MCU] does not 

match the model conversion mode.  

[Action by User] When [Multi-Core MCU] has been set, click on the [Convert Model for Multicore MCU] 

button.  

[Message] E0111  

e2 studio does not support the specified device name. 

[Explanation] This error message is displayed when CS+ does not support this device name  

 

[Action by User] • Check if [Device Name] is correct. 

Check if e2 studio supports the specified device name. 

[Message]  E0112  

 Software Trace is not selected for Measurement Method. 

[Explanation]  This error message is displayed when [Performance Function] is set in [Measurement 
Method].  

 

[Action by User]  Set [Software Trace] in [Measurement Method].  

[Message] E0115 

File <target file> has been changed. 

[Explanation] The ecpils files in package has been changed or any file which same name in the 
current workspace. 

[Action by User] • Re-install Embedded Target 

Check whether the files in current workspace have the same name as describe in the 
error message by use “which –all  <target file> “? If so, rename the files in the 
workspace. 
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4.3 Errors at Build 

The following table lists the messages that are detected at build. 

Table 4-2. Error Messages at Build 

[Message] E0201 

Please exit <IDE Target>, which has started. 

[Explanation] CS+ or e2 studio has already been started. 

[Action by User] • Exit the active CS+/e2 studio and execute rebuilding. 

• Terminate the CS+/e2 studio process on the Windows® task manager. 

• Check that the rapid start function of CS+/e2 studio is not used. 

[Message] E0202  

The current mex compiler configuration is not supported. 

[Explanation] The current compiler tool chain in MATLAB® doesn't contain: mingw64, MSVC 
(Microsoft Visual Compiler) 

[Action by User] Install MinGW, MSVC compatible with MATLAB® version  

[Message] E0203 

The selected template project file does not exist. 

[Explanation] The address of template project which specified on Embedded Target options is not 
correct. 

[Action by User] Correct address of the template project 

[Message] E0204 

The current working directory does not contain model <ModelName>. 

[Explanation] Code generation during the build caused errors if current directory is different from 
project directory. Therefore, Embedded Target will throw warning before generating 
the code. 

[Action by User] Change the current directory to project directory. 

[Message] E0205  

Opening the PIL simulation communications channel was not possible. 

[Explanation] This error message displayed when user want to stop the PIL simulation by click 
[OK] button in  Figure 3-36. Confirmation Dialog Box 

[Action by User] While Embedded Target is building and show message box to stop PIL simulation 
don’t click [OK]. 

[Message] E0206  

The GenCodeOnly option is not supported. 

[Explanation] This error message displayed when the [Generate code only] checkbox is checked. 

[Action by User] Uncheck [Generate code only] checkbox. 

[Message] E0207  

The Create Block option is not set to "PIL". 

[Explanation] [PIL] is not set to [Create Block] in the Configuration Dialog. 

[Action by User] Open the Configuration Dialog for target model. -> Select All Parameter -> Search 
for the [Create Block] option -> Specify [PIL] to [Create Block]. 
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4.4 Errors during Starting CS+/e2 studio and Downloading 

The following table lists the messages that are detected in Embedded Target processing from starting CS+/e2 

studio to downloading. 

Table 4-3. Error Messages in CS+/ e2 studio 

  

[Message] E0300 

Creating the <IDE Target> project was not possible (project.Create error). 

[Direct Cause] 

<The direct error cause message> 

[Explanation] The CS+ or e2 studio project file could not be generated. 

[Action by User] • Check that the CS+ or e2 studio version is supported by Embedded Target. 

• Check that the CS+ Python plug-in is enabled. 

• Check that the e2 studio support area is specified correctly. 

[Message] E0302 

Adding the source file was not possible (project.File.Add error). 

[Explanation] The source file could not be registered in the CS+ project file. 

[Action by User] Check that the MATLAB® version is supported by Embedded Target. 

[Message] E0303 

Removing the source file was not possible (project.File.Remove error). 

[Explanation] The source file could not be removed from the IDE project file. 

[Action by User] When "Template Project & LM Download" is selected for IDE Mode, check that the 
IDE project created by Embedded Target has been specified. 

[Message] E0304 

Setting the debug tool was not possible (debugger.DebugTool.Change error). 

[Explanation] Cannot change to target Debug Tool, which was set on [Embedded Target options] 
panel. 

[Action by User] Confirm available connection types (when using E1/E2 emulator) on CS+ project. 

Re-generate test environment again. 

[Message] E0311 

Generating the wrapper function was not possible (model.analyze error). 

[Explanation] An error occurs when the Embedded Target cannot find related source files 
generated by Embedded Coder toolbox. 

[Action by User] Check if any error occurs during the build process on MATLAB side. 

If any, fix the issue and then re-generate the test environment. 
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[Message] E0312 

Building was not possible (build.All error). 

[Explanation] An error occurred at build. 

[Action by User] Check the following and regenerate the test environment. 

• Review the property setting of CS+/e2 studio. 

• Check the error message displayed in the CS+/e2 studio output panel. 

• When the memory size of the device is small, consider the use of a device of 

large memory size. 

[Message] E0320 

Connecting the debug tool was not possible (debugger.Connect error). 

[Explanation] An error occurred at connecting the debug tool. 

[Action by User] • Check the property setting of CS+/e2 studio. 

• Check that E1/E2/E2 Lite/E20 (JTAG/Serial)/EZ/COM Port/J-Link have been 

correctly connected. 

[Message] E0321 

Downloading the load module was not possible (debugger.Download.LoadModule 
error). 

[Explanation] An error occurred at downloading a load module. 

[Action by User] • Check the property setting of CS+/e2 studio. 

• Check that no error occurred at build of CS+/e2 studio. 

[Message] E0322 

Setting the timer event was not possible (debugger.Timer.Set error). 

[Explanation] An error occurred when cannot set time events. 

[Action by User] Re-allocate core assignment on Simulink® model to reduce the number of timer 
events. 

Re-generate and re-execute load module from embedded model. 

[Message] E0323 

Opening the e2 studio project was not possible (project.Open error). 

[Explanation] The e2 studio project file could not be imported to workspace in e2 studio IDE. 

[Action by User] • Check that the e2 studio version is supported by Embedded Target. 

• Check that the e2 studio support area is specified correctly. 
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4.5 Errors during PIL Simulation 

The following describes error messages detected during PIL simulation. Error dialog boxes during PIL simulation 

are output from MATLAB®/Simulink®. 

 

Figure 4-1. Messages in the Error Dialog Box during PIL Simulation 

Table 4-4. Actions for Errors during PIL Simulation 

[Action by User] (1) Check that CS+/e2 studio has been started 

(2) Check that the debug tool of CS+/e2 studio is connectable 

(3) Check that the program has been downloaded to CS+/e2 studio 

(4) Check that multiple CS+/e2 studio has not been started 

(5) Check that the rapid start function of CS+/e2 studio has not been used 

(6) Terminate all processes of MATLAB® and CS+/e2 studio 

(7) Use Windows® Task Manager to terminate process regarding CS+/e2 studio 

  (7-1) Right click on the Task Bar of Windows®, click on “Start Task Manager” 

  (7-2) In the Windows® Task Manager window, choose Processes tab 

  (7-3) Check whether the CubeSuiteW+.exe process has existed. If no, right click 

on that item and choose End Process item 

(8) Modify the value of “3000” of Buffer Size option that has been defined in 

Embedded Target Options 

(9) Start MATLAB® 

Re-execute PIL simulation 
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The following describes error messages detected when you get visual display of the execution time in algorithm 

verification after PIL Simulation. Error dialog boxes during PIL simulation are output from MATLAB®/Simulink®. 

 

Table 4-5 Error Messages during PIL simulation 

 

  

[Message] E0501 

Trace_Data.csv does not exist. 

[Explanation] The execution time measurement result file does not exist in the generated folder of 
the PIL build process. 

[Action by User] • Re-confirm if the [Measure Execution Time] checkbox is check. 

• Check if the correct time measurement method is used, it is specified in 

[Measurement Method] button. 

• If above information is correct, re-execute PIL Simulation to generate 

execution time measurement result file. 

[Message] E0502 

Total_time.csv and Worst_time.csv are in the wrong format or empty. 

[Explanation] The execution time measurement result is empty or is stored in a wrong format. 

[Action by User] • If the [Measurement Method] is [Software Trace], check if the model is 
correctly converted for the purpose - refer to 3.2.1 Procedure for Manually 
Specifying Core Targets (Multi-Core MCU). 

• If the PIL Simulation finished successfully, re-execute PIL Simulation to 
generate the result file. 
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4.6 Errors during Model Conversion 

The following table lists the error messages that are displayed when errors are detected during model 

conversion. 

Table 4-6. Error Messages during Model Conversion 

  

[Message] E0412 

Execution of the model conversion script failed. 

[Explanation] This error message is displayed when execution of the script file for model 
conversion failed. 

[Action by User] Check information of the input file and make sure the settings of the model are 

correct before converting it. 

[Message] E0413 

Creating core allocation pattern files for model conversion was not possible. 

[Explanation] This error message is displayed when the intermediate files to be used in model 
conversion cannot be generated. 

[Action by User] If M2PinterfaceCore.csv and M2PInterfaceConn.csv already exist, make sure they 
are not being opened by another program. 

[Message] E0414 

ECPILS_Core.csv and ECPILS_Conn.csv do not exist. 

[Explanation] The "ECPILS_Core.csv" and "ECPILS_Conn.csv" files do not exist. 

[Action by User] The core allocation information is missing or incorrect. Re-generate the information. 

[Message] E0415 

Getting information on conversion failed. 

[Explanation] The model parameters cannot access model information for some reason. 

[Action by User] Check whether the model has been opened before using the ecpils_convert_model 
command. 

[Message] E0416 

Converting the model was not possible. 

[Explanation] The conditions required for model conversion are not satisfied. 

[Action by User] Check if the following conditions are satisfied.  

• The automation server must be set up correctly.  

• The button for model conversion appropriate for the selected [Target MCU] must 
be clicked on.  

• [Software Trace] must be set in [Measurement Method].  

• The device set in [Device Name] must be supported by e2 studio. 

[Message] E0417 

The model has already been converted. 

[Explanation] An attempt was made to covert a model that has already been converted. 

[Action by User] Use a model that has not been converted. 

[Message] E0418 

Multiple model conversion parameters are specified. 

[Explanation] The number of input arguments of the ecpils_convert_model command is not one. 

[Action by User] Specify either [Single-Core MCU] or [Multi-Core MCU]. 
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[Message] E0419 

Failed by the search processing at list of candidate for measurement block. 

[Explanation] An error has occurred due to one of the following reasons:  

• The format of the signal name of the Multi-rate model and scheduler in use is 
incorrect. The format must be “u1_XXtic_out”.  

• The list of measurement target blocks cannot be written to the measurement target 
information file due to the lack of access permission. 

[Action by User] • Check the signal name of the scheduler.  

• If the measurement target information file already exists, make sure it is not being 
opened by another program. 

[Message] E0420  

Failed by the connection search processing. 

[Explanation] This error message is displayed when the intermediate files to be used in model 
conversion cannot be accessed 

[Action by User] If M2PinterfaceCore.csv and M2PInterfaceConn.csv already exist, perform model 
conversion after confirming that you have permission to access the files. 

[Message] E0421  

There is no candidate for measurement target.  

Please put only “usable blocks'' under the code generation target. 

[Explanation] The list of measurement target blocks in the measurement target information file is 
empty. 

[Action by User] Confirm the following conditions and then re-execute model conversion. 

• There must be at least one Subsystem block under the code generation target 
block.  

• Only usable blocks must be placed under the code generation target block. 

[Message] E0601  

Changing rate information was not possible because the scheduler does not meet 
the required specification. 

[Explanation] This error message is displayed when the output port name of the scheduler is in an 
incorrect format (e.g. not u1_XXtic_out). 

[Action by User] Check if the output port name of the scheduler is correct. Another solution is to 
delete the current Scheduler block and execute the 
ecpils_create_sample_multi_rate_scheduler command to create a new Scheduler 
block 

[Message] E0603  

The number of existing Scheduler outports does not match the number of new 
Scheduler outports. 

[Explanation] The number of arguments of the ecpils_create_sample_multi_rate_scheduler 
command is incorrect. 

[Action by User] Set the number of rate values of the ecpils_create_sample_multi_rate_scheduler 
command to be equal to the number of output ports of the Scheduler block. 

[Message] E0700  

No Subsystem or duplicate Subsystems are selected as the target of measurement. 

[Explanation] This error message is displayed when there is a mistake in checkboxes when 
selecting the form for specifying measurement targets. 

[Action by User] This is an internal error. Please contact a Renesas Electronics sales office. 
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[Message] E0701  

Output of the Core.csv file was not possible. 

[Explanation] This error message is displayed when the intermediate files to be used in model 
conversion cannot be generated. 

[Action by User] Check if there is an M2PinterfaceCore.csv file that you have permission to access. 
If M2PinterfaceCore.csv that is generated from ECPILS_Core.csv already exists, 
make sure it is not being opened by another program. 

[Message] E0702  

Output of an export file was not possible. 

[Explanation] This error message is displayed when the measurement target information file 
cannot be generated. 

[Action by User] If the measurement target information file already exists, make sure it is not being 
opened by another program. 

[Message] E0703  

Import of the selected model failed. The target of code generation in the imported 
file differs from that of the actual model. 

[Explanation] Import of the measurement target information file failed due to one of the following 
reasons:  

• The measurement target information file may have been modified manually.  

• The measurement target information file may be for a different model or a different 
code generation target block. 

[Action by User] Re-confirm with the measurement target information file that the code generation 
target and target model for mode conversion are correct. If they differ, the 
measurement target information file cannot be used. Re-create the measurement 
target information file. 

[Message] E0704  

Import of the selected model failed. The structure of the model in the imported file 
differs from that of the actual model. 

[Explanation] Import of the measurement target information file failed due to the following reason. 
Though the model and code generation target are correct, the internal structure of 
the code generation target has been changed (e.g., usable blocks were added, 
block name was changed). 

[Action by User] Re-confirm with the measurement target information file that the code generation 
target has the same model structure as the target model for mode conversion. If 
they differ, the measurement target information file cannot be used. Re-create the 
measurement target information file. 

[Message] E0705  

Input of an import file was not possible. 

[Explanation] This error message is displayed when importing of the measurement target 
information file failed for some reason (e.g., not having access permission). 

[Action by User] Re-import the measurement target information file after confirming that you have 
permission to access it. 

[Message] E0706  

Cannot get model information or wrong information. 

[Explanation] This error occurs at startup of the form for specifying measurement targets. 

[Action by User] This is an internal error. Please contact a Renesas Electronics sales office 
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[Message] E0801  

Output of the script file was not possible. 

[Explanation] An error has occurred due to one of the following reasons:  

• The format of M2PinterfaceConn.csv and M2PinterfaceCore.csv is incorrect.  

• Does not have permission to access TestModelScript.m. 

[Action by User] • Re-create the measurement target information file.  

• If TestModelScript.m already exists, make sure it is not being opened by another 
program. 
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